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1. Introduction  

This document provides hardware and software installation instructions for the 
EyeLink 1000, 2000 and Remote systems using the Tower, Desktop, Primate or Arm 
Mounts. For the simplicity of presentation, these eye trackers are collectively referred to 
as the EyeLink 1000 throughout this document, with important exception noted where 
necessary. The EyeLink 2000 involves a camera programmed for higher acquisition 
speeds and the EyeLink Remote involves a camera programming update to enable 
remote recoding without head stabilization. While the EyeLink 2000 is compatible with 
all mount options, the EyeLink Remote works with only the Desktop and Arm Mounts. 

 

IMPORTANT: Before proceeding with the EyeLink 1000 installation ensure 
you have backed up all important data on your Host PC. 

 

The basic steps in installing the EyeLink 1000 system are: 

1) Unpack and Install the EyeLink 1000 Hardware. This includes connecting the 
Host PC to the Display PC via an Ethernet link. 

2) Install necessary Operating System and EyeLink 1000 Host Application software 
on the PC your have selected to act as your Host PC.  

3) Install the EyeLink 1000 Windows Software (API and example experiments) on 
the Display PC. 

4) Test the installation. 

The installation process will take about 2 hours, so try and do it when you have this 
amount of time to dedicate to the process.  

If you have questions or encounter a problem during the installation process, please 
contact SR Research through one of the contact channels listed at: 

http://www.sr-research.com/contact.php 

If you would like to ensure that a technical representative is available for direct phone 
support during your installation, please contact your SR Research representative to 
book a time for installation phone support. We will ensure that a technical 
representative is available to speak on the phone with you if required during your 
installation if you inform us of your installation time with at least one week’s notice. 
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1.1 Suggested Equipment Layout 

The layout of the EyeLink 1000 equipment is important if participant setup is to be 
convenient, and lighting problems are to be avoided. Before setting up equipment, 
check the arrangement of the room to be used against these suggestions. These will aid 
in the production of good experimental data. 

• Set up the host and display monitors and PCs on tables arranged in an ‘L’ shape, as 
in Figure  1-1. This configuration allows the experimenter to adjust the eye tracker 
device and set up the subject for the experiment while having access to both 
computer keyboards and monitors. 

 

Figure  1-1 Suggested EyeLink 1000 System Layout  

 

• If you are using the chinrest that comes with the eye tracker, please make sure you 
have a table available to mount the table clamp. This table must have a minimum 
thickness of 1.8 cm and a maximum thickness of 8.0 cm. The bottom edge of the 
table should have a depth of at least 6.0 cm to mount the integrated table clamp. 
Please also ensure that the table is deep enough to accommodate both the monitor 
(especially for a CRT monitor) and eye tracker. For a 21’’ CRT monitor with a 30° 
viewing angle, the minimum table depth should be about 130 cm.  

• Avoid windows or other bright light sources that could cause reflections on the host 
and display monitors. The grey walls highlighted in Figure  1-1 are locations where 
bright light sources will cause reflections. 



 

Introduction 
© 2005-2008 SR Research Ltd. 

3 

 

• Supply sufficient light in the room. The best way to light the room is with ceiling-
mounted fluorescent lights, above and no more than 2 meters behind the computer 
monitors. Painting the walls light colors or white will maximize ambient light as well. 

• Avoid environmental distractions. Be sure the room can be kept quiet, that no 
posters or other items are on the wall seen by the participant, and so on. It is also a 
good idea to make sure the participant cannot see the host monitor, without turning 
their head (discourage this). 

• Supply a comfortable, stable chair for the participants. It should not wobble or move 
when sat in, and the back should be firmly attached to the seat - springiness 
encourages some participants to rock forwards and back. A chair with a concave 
back also discourages shifting of the body, as does a high back. The top of the chair 
back should be just below the shoulders on an average participant. Finally, make 
sure participants can enter and leave the chair easily, as the chair will be close to 
the table with the Display PC monitor.  

• Set up the Display PC monitor and chair so that the participant’s eyes will be at a 
distance from the monitor of about twice the width of the display area of the Display 
monitor. This distance gives a display area of 28° by 22°. This is the ideal distance 
for both calibration accuracy and tracking range. This standard distance is assumed 
in all EyeLink 1000 documentation. 

1.2 Pre-installation Checklist 

Ensure that you have the following resources available before you start installation. 
These items have all been provided with your EyeLink 1000 system shipment: 

1. EyeLink 1000 Mount which is one or more of the following. Each Mount option 
has a separate chapter to be consulted regarding its installation. 

• EyeLink 1000 Tower Mount (includes IR mirror, built in IR illuminator, 
and chinrest) 

• EyeLink 1000/EyeLink Remote Desktop Mount (includes integrated IR 
illuminator, and optional chin rest and forehead rest) 

• EyeLink 1000 Arm Mount (includes integrated IR illuminator, LCD 
monitor and flexible monitor Arm with optional chin and forehead rest) 

• EyeLink 1000 Primate Mount (includes integrated IR illuminator) 

2. EyeLink CL High Speed Infrared Camera 

3. Phoenix frame grabber – PCI card 
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4. DLINK DFE538-TX Ethernet PCI card 

5. Power supply for the EyeLink CL High Speed Infrared Camera. 

6. CameraLink cable to connect EyeLink CL camera to PCI frame grabber card. 

7. Ethernet crossover cable to connect Host and Display PC together. 

8. “EyeLink 1000 Software” CD. Please note that each EyeLink 1000 system loads 
a camera-specific .SCD file and therefore, you should use the EyeLink 1000 
Installation CD that comes with your system. 

9. One ROM DOS Boot CD labeled “ROM-DOS Boot CD” 

10. One System Commander Boot CD labeled “System Commander Boot CD” 

11. USB Button Box to be attached to the host computer and USB extension cord. 

 

You will also need the following components that may not have been provided with 
your EyeLink 1000 base system: 

1. A Host PC that meets the minimum required specifications. For guaranteed 
success, consult SR-Research for a list of Dell systems that have been tested 
and found compatible. Minimum requirements are listed in section 2.1.1. The 
Host PC may have been purchased with your base system. 

2. A Display PC that meets the minimum required specifications. These 
specifications are listed in section 2.1.2. 

3. Any tools required for accessing your Host PC’s case (usually a Phillips 
screwdriver will do). 

 

If an analog card option was purchased, you should also have: 

1. Full length PCI Analog card  

2. Analog breakout board 

3. Cable to connect analog PCI card to breakout board. 
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1.3 Computer Specifications 

1.3.1 Host PC 
The PC that will host the EyeLink hardware and software must meet certain 
specifications due to the nature of the operating system that the EyeLink Host 
application runs under. As computer technology is rapidly changing, only systems 
tested and approved by SR Research Ltd. can be guaranteed to work.  
 
In the interest of not instructing our customers to purchase computer equipment only 
to encounter difficulties with their installation, the reader is directed to consult the web 
page http://www.sr-research.com/compatibleHostPCs.html for a list of systems known 
to be compatible and accurate when running the EyeLink hardware and software. 

1.3.2 Display PC 
The specifications for the PC that will be used for system calibration and experiment 
presentation depend greatly on the type of experimental paradigms that the EyeLink 
1000 will be used for. For example, gaze contingent paradigms generally require more 
computing power than simple cognitive paradigms because the computer display needs 
to be updates as quickly as possible. Similarly, video intensive experiments may need 
faster hard disks to support the transfer of large video file data to the computer in a 
timely manner. The following requirements are suggestions for a Display PC 
configuration that should be able to handle most experimental requirements. Please 
contact a SR Research Ltd. Representative if you have specific questions about your 
situation and would like our input.  

• > 2.0 GHz or faster processor (Pentium 4 or AMD).  
• 80 GB hard disk with 7,200 rpm 
• Video card supporting vertical refresh rates of 100 Hz 
• A CD-ROM writer for software installation and data backup. 
• At least 512 MB RAM (1-2 GB recommended) 
• 32 bit Windows 2000 or 32 bit Windows XP (service pack 2) 
• 17” or larger monitor that supports vertical refresh rates of >= 100Hz (10 ms 

frames) and horizontal refresh rates > 100 kHz. 
• Ethernet card to connect Display PC to the EyeLink 1000 Host PC. 
• Optional Ethernet card for use on local network (a separate network card should 

be used to connect to the EyeLink 1000 system) 
• A keyboard and mouse or other pointing device. 
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2. Host PC Hardware Installation 

IMPORTANT: Switch off the computers before installing any PCI cards or 
connecting or disconnecting any cables! Ensure that all cabling is properly 
connected and connectors are properly secured to the Host PC and the 
EyeLink CL camera before use. 

IMPORTANT: Ensure that the power supply setting on the back of the 
PC (Near the power jack) matches your local supply voltage! 

WARNING: Static Electricity Discharge may cause permanent damages 
to your system. In order to avoid possible static electricity discharge 
during installation, please discharge any static electricity accumulated 
in your body by touching a grounded metal surface or the computer 
case for a few seconds. 

2.1 Unpacking 

Open the shipping case. If you are unpacking the large shipping box that contains 
the EyeLink 1000 Tower Mount, please be careful as it contains glass that may 
have been broken during shipping. If the system has been stored or transported at a 
temperature below 10°C, allow all parts to warm to room temperature before 
proceeding. 
 
   

IMPORTANT: Save the shipping case and all packing material for storage or 
in case the unit needs to be returned for repair. 

IMPORTANT: The EyeLink 1000 Tower assembly should be held by the 
vertical posts and should NEVER be held by the mirror or the 
components attached to the mirror. 

2.2 Host PC Hardware Installation 

2.2.1 Setting Up the Host PC Computer and Monitor 
Unpack your Host PC as per the instructions provided with the computer by the 
computer manufacturer and set up the computer at the desired location. This includes 
connecting the keyboard and mouse to the computer, as well as the power supply and 
monitor cables.  
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If your EyeLink 1000 system was supplied with the hardware preinstalled into a 
supplied Host PC, please skip to the section detailing the EyeLink 1000 mount option 
that you wish to set up.  
To set up your Host PC for use with the EyeLink 1000 system, you will be required to 
open the computer chassis to install two or three PCI cards. Therefore, put the 
computer case in a position where you can easily access the computer’s PCI slots. 
   

IMPORTANT: Ensure the computers power cable is disconnected before 
opening the computer chassis to install any PCI card. 

IMPORTANT: Handle the cards only by their edges. 

 

2.2.2 Installing the Phoenix High Speed Frame Grabber - PCI card 
 
Open the EyeLink 1000 host PC, and insert the Phoenix High Speed Frame Grabber 
card into a free PCI slot. Ensure the card’s bracket is firmly attached to the PC. 
 

    

Figure  2-1 Phoenix High Speed Frame Grabber 

2.2.3 Installing the DLINK DFE-538TX Ethernet Card 
Insert the DLINK DFE-538TX Ethernet Card into a free PCI slot. Ensure the card’s 
bracket is firmly attached to the PC. If the analog card option was not purchased with 
your system, you may now close the computer chassis and reconnect the power supply 
to the computer. 
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Figure  2-2 Ethernet Card 

2.2.4 Installing the Data Translation Analog Card (Optional) 
If the analog output option was purchased with your system, then insert the Data 
Translation Analog output card into a free PCI slot. Ensure the card’s bracket is firmly 
attached to the PC. Close the computer chassis and reconnect the power supply to the 
computer.  
 

 

Figure  2-3 Analog Card 

2.3 Display PC Hardware Installation 

Unpack your Display PC as per the instructions provided with the computer by the 
computer manufacturer and set up the computer at the desired location of the Display 
PC. This includes connecting the keyboard and mouse to the computer, as well as the 
power supply and monitor cables. 

   

Continue on to the section pertaining to the mounting option that you 
are installing: 

Tower Mount –    4 “Tower Mount Installation” 

Desktop Mount –  5 “Desktop Mount Installation” 

Arm Mount –      6 “Arm Mount Installation” 

Primate Mount –  7 “Primate Mount Installation” 
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3. Tower Mount Installation 

Please follow the steps below to mount the EyeLink 1000 Tower onto the table and to 
install the camera. Figure  3-1 illustrates adjustable parts on the EyeLink 1000 Tower.  

 

Figure  3-1 Components of EyeLink 1000 Tower 
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3.1 Mounting the Tower to a Table 

Important: The head support Tower should only be held by the vertical 
posts and should NEVER be held by the mirror or the components 
attached to the mirror. We recommend you have somebody available to 
assist you mounting the head-support Tower onto the table to prevent 
damages to the IR mirror or other parts of the Tower.  

 

Check whether the table is suitable for mounting the EyeLink 1000 Tower – the table 
used should have a minimum thickness of 1.8 cm and a maximum thickness of 8.0 cm.  

 

Figure  3-2 Clamping Chinrest to Table 

Loosen the table clamp by turning the knob counterclockwise, then place the table 
clamp fully onto the table, and then tighten it clockwise (see Figure  3-2). Check that it 
is firmly secured by gently attempting to rock the table clamp base free. If the table 
clamp base wobbles you will have to tighten it further.  
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Figure  3-3 Placing and Adjusting Tower Mount 

The camera mount is quite heavy and cumbersome to move. For safety purposes it is 
recommended that two people participate in setting up this piece of the equipment. One 
person can support the weight of the camera mount while the other lines the spring-
loaded clamps with holes in the Tower poles. When released, the clamps secure a peg 
into the holes of the Tower poles, thereby supporting the weight of the camera mount. 

Gently pick up the camera mount with the mirror facing away from you. It is 
recommended that you hold the camera mount near the Tower height adjustment 
knobs as shown in the left side of Figure  3-3. Be careful not to scratch or touch the 
mirror. Now line the mount up with the vertical posts and gently lower it into position. 
The camera mounting should rest about ½ inch into the hole. 

Once the Tower Mount is placed onto the Tower poles you will need to adjust its height 
by pulling simultaneously the Tower height adjustment knobs away from the poles on 
both the left and right hand side (see right side of Figure  3-3). Be careful as you still 
have to support the weight of the camera mounting unit. Make sure that the unit does 
not fall down the poles. If at any point the camera mounting unit does begin to fall, 
releasing the spring-loaded height adjustment will cause them to lock into one set of 
holes in the Tower poles, preventing the Tower from falling further.  

Gently lower or raise the camera mount by pulling to release the height adjustment 
knobs, and raising or lowering the unit until the knobs are in line with the center of the 
display monitor (see Figure  3-4). This will produce an optimal viewing angle for 
participants. Once the Tower height is set for a normal operation, it does not need to be 
adjusted further. The experimenter should adjust the heights of the chair and/or chin 
rest on a participant to participant basis.  
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Figure  3-4 Adjust Height of Tower to Half the Screen 
Area of Monitor 

3.2 Mounting the EyeLink CL High Speed Camera  

The 25 mm lens should be used on the EyeLink 1000 Tower Mount. Hold the camera 
with the lens facing downwards and the focusing arm on the right. Align the hole on the 
camera to the screw on the top of the Tower and tighten the screw knob from below. 
Please make sure the camera lens is not dusty or scratched! 

 

Figure  3-5 Views of the EyeLink 1000 Tower and 
Camera 
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Figure  3-6 Camera and Illuminator Cables on EyeLink 
1000 Tower 

After the camera is mounted onto the Tower, connect the EyeLink CL power supply that 
was provided with your system to the power connector on the left side of the EyeLink 
CL camera. Connect the two illuminator cables that come out of the left side of the head 
support Tower to the left side of the EyeLink CL high-speed camera: plug the cable 
marked with “R” to the port marked with “R” and the one with “L” to the remaining port.  

3.3 Adjusting Head Rest Components 

The height of the forehead and chinrest can be adjusted by loosening the knobs on both 
sides of the Tower. After sliding the chinrest to the desired position, re-tightening the 
knobs.  

 Set up the monitor and chinrest so that the chinrest is centered on the monitor and 
the monitor is horizontally aligned with the chinrest (HINT: measure from the left 
and right knobs on the chinrest to the left and right sides of the top of the display 
area of the monitor, these should be equal). 

 Adjust the tilt of the monitor and height of the forehead rest. Ideally this should 
have the top of the display at about the same height as the forehead rest, and the 
display tilted up slightly. The tilt can be changed if there are any reflection issues. 
Please follow “Section  10.1 Customizing Your PHYSICICAL.INI Settings” to modify 
the PHYSICAL.INI file settings.  



 

14 Desktop Mount / EyeLink Remote Installation 
© 2005-2008 SR Research Ltd. 

 

4. Desktop Mount / EyeLink Remote Installation 

Please follow the steps below to set up the EyeLink 1000 Desktop Mount. Figure  4-1 
illustrates adjustable parts of the EyeLink 1000 Desktop Mount. 

 

 

Figure  4-1 EyeLink 1000 Desktop Mount Components 

4.1 Mounting the EyeLink 1000 High Speed Camera  

The EyeLink 1000 Desktop Mount can be configured to track eye movements up to 
2000 Hz monocularly or 1000 Hz binocularly (with the 2K option). The angle of the 
high-speed camera and the position of the camera screw should be adjusted differently 
depending on the mount type you plan to use. Each mount type works optimally with 
different camera lenses (see Table 1). While the 2K camera option works with all lenses, 
the EyeLink Remote option works best with only the 16 mm lens. 
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Figure  4-2 Desktop Mount Camera Adjustment 

Follow the steps below to mount the high-speed camera for monocular tracking or to 
use the EyeLink Remote – the Camera Level position (see Figure  4-3):  

1. Place the Desktop Mount on the table. Turn the 35 mm camera lens into the 
thread on the camera. See Table 1 for recommended lens usage.   

2. Move the camera screw to the top end of the slot.  

3. Hold the camera with its elongation parallel to the table (and level with the top 
of the mount), align the hole on the camera to the camera screw on desktop 
mount, and then tighten the camera screw.  

 

Figure  4-3 Camera Level Position for Remote and 
Stabilized Monocular Recording 
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Lens 
Aperture Size 

Tower Mount Desktop Mount 
(Camera Level) 

Desktop Mount 
(Camera Angled) 

Arm Mount  
(Camera Level) 

EyeLink Remote 
(Camera Level) 

16 mm 
(Short Arm) - - - IDEAL IDEAL 

25 mm 
(Long Arm)  IDEAL 

Possible – closer 
distance 

suggested 
IDEAL 

Possible – closer 
distance 

suggested 
- 

35 mm - IDEAL 
Possible – further 

distance 
suggested 

Possible – 
further distance 

suggested 
- 

Table 1. Recommended Lens Usage 

For binocular tracking (see Figure  4-4):  

1. Place the Desktop Mount on the table. Turn the 25 mm camera lens into the 
thread on the camera. See Table 1 for recommended lens usage. Move the 
camera screw to the bottom end of the slot.  

2. Hold the camera with its elongation forming a 45-degree angle relative to the 
table. Align the hole on the camera to the camera screw on desktop stand, and 
then tighten the camera screw. Dimples in the camera align with protrusions on 
the mount to ensure the camera is in the right position. 

 

Figure  4-4 Camera Angled Position for Stabilized 
Binocular and monocular Recording 

After the camera is mounted onto the Desktop Mount, connect the EyeLink CL power 
supply that was provided with your system to the power connector on the left side of 
the camera (see  
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Figure  4-5). Connect the two illuminator cables that come out of the Desktop Mount to 
the left side of the EyeLink CL high-speed camera.  

 

 

 

 

 

Figure  4-5 Camera and Illuminator Cables from 
Desktop Mount 

4.2 Adjusting the Desktop Mount (Monocular, Binocular and Remote 
Recording) 

Place the Desktop Mount on the table at a distance between 40 and 70 cm from the 
participant’s eyes, with the illuminator and eye camera facing the participant; the 
recommended tracking distance is 50 to 55 cm. The camera screw of the Desktop 
Mount should be aligned to the center of the display PC monitor and the top of the 
illuminator should be as close to the lower edge of the visible part of the monitor to 
maximize the eye tracking range. 

If you are using the chin rest supplied by SR Research Ltd., please check whether the 
table is suitable for mounting the chin rest – the table used should have a minimum 
thickness of 1.8 cm and a maximum thickness of 8.0 cm. Loosen the table clamp by 
turning the knob counterclockwise, place the table clamp fully onto the table, and then 
tighten it clockwise (see Figure  3-2). Check that it is firmly secured by gently attempting 
to rock the table clamp base free. If the table clamp base wobbles, tighten it further. 
Next, place the forehead rest over the chinrest poles and tighten the knobs at the 
desired height. 

Please check that the chinrest is horizontally centered with the monitor. Adjust the tilt 
of the monitor so that the display is tilted up slightly. The tilt can be changed if there 
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are any reflection issues. Please follow “Section  10.1 Customizing Your PHYSICICAL.INI 
Settings” to modify the PHYSICAL.INI file settings. 

4.3 EyeLink Remote Hardware Adjustment for the Desktop Mount 

The default version of the EyeLink Remote uses the Desktop Mount and an EyeLink 
1000 High Speed Camera programmed for Remote viewing. Users who are exclusively 
interested in installing the EyeLink Remote should first follow installation instructions 
for the Desktop Mount, then continue below. 

To use the EyeLink 1000 in remote mode, the viewer is ideally about 60-70 cm from the 
display surface. The height of the monitor should be set so that when the participant is 
seated and looking straight ahead, they are looking vertically at the middle to top 75% 
of the monitor. Once you have set up the system, make sure you have updated 
PHYSICAL.INI, which is located at C:\ELCL\EXE folder of the host computer. Please 
follow “Section  10.1 Customizing Your PHYSICICAL.INI Settings” to modify the 
PHYSICAL.INI file settings. 

Check whether the camera is set to the Level position – the elongation of the camera 
should be parallel to the table (see section  4.1 “Mounting the EyeLink 1000 High Speed 
Camera”). Place the eye tracker right in front of the monitor; the camera screw should 
be horizontally aligned to the center of the monitor. For maximum eye tracking range, 
the eye tracker should be raised so that the top of the illuminator is as close as possible 
to the lower edge of the visible part of the monitor without blocking the subject’s view.  

Internally the eye tracker software was designed to perform based on these 
assumptions. Variability by a couple of centimeters will not have an impact on the 
tracker accuracy while a larger deviation from the recommended settings may cause 
performance issues. Contact SR Research Ltd. if your experiment requires substantial 
deviation from the above guidelines. 
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5. Arm Mount Installation 

Please follow the steps below to set up the EyeLink 1000 Arm Mount. Figure  5-1 
illustrates a typical Arm Mount setup and Figure  5-2 illustrates parts of the EyeLink 
1000 Arm Mount as it ships from SR Research under its standard configuration. The 
mount first requires fixing the Arm Base to a sturdy tabletop, assembling the arm 
components, attaching the EyeLink High Speed Camera and then attaching cables. The 
following instructions detail each of these procedures.  

The contents of the Figure in clockwise direction, starting at the top, are: the Camera 
and LCD Assembly, three Velcro strips (rolled and piled), cabling emerging from the end 
of the Arm (which runs diagonally throughout the photo), the Arm Base, two L-shaped 
Imperial Allen wrenches, 2.5” and 6” extender tubes, the Arm, and two angled brackets. 
Not shown in the photo are pieces of the monitor that allow it to be used with a 
traditional table mount should the user ever wish to remove it from the Arm Mount for 
conventional use, the monitor driver CD and instruction booklet, and extension cables 
(SVGA, audio and power). 

 

 

Figure  5-1 Typical EyeLink 1000 Arm Mount 
Installation 
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Figure  5-2 EyeLink 1000 Arm Mount Components: Arm 
Mount Base, Arm, Camera and LCD Assembly 

5.1 Choosing a Table  

Before mounting the Arm, and the Camera and LCD Assembly, the Arm Base (see 
Figure  5-2 and Figure  5-3) must be affixed to a sturdy table. The Arm Base can 
accommodate tables up to a thickness of 75 mm (7.5 cm, 2.5”) at a depth of 18 mm to 
65 mm (1.8-65 cm, 1.25”). The footprint of the Arm Base above the table is 160 mm 
wide x 140 mm deep (16 cm or 6 ¼” X 14 cm or 5 ½”) and requires further clearance for 
the arm to swing in any direction.  

The minimum depth for mounting on the table underside that the system can work 
with is an 18 mm ledge (in which case the maximum table thickness is 60 mm – 6 cm 
or 2 3/8”). 

The Arm Mount can displace the Camera and Monitor Assembly from 11 cm below the 
surface level of the table to which it is mounted, to 23 cm above it. This places the 



 

Arm Mount Installation 
© 2005-2008 SR Research Ltd. 

21 

 

bottom of the monitor from 2 cm below the table surface to 32 cm above it. Two arm 
extender units are shipped with the mount that can displace these measurements 
upwards by a further 6, 15 or together 21 cm (for a dynamic range of -11 to 44 cm, or 
considering the bottom of the display -2 cm to 53 cm). The arm can extend a distance of 
75 cm from the base in any direction, with a minimal extension of 48 cm.  

The desired viewing level of the participant should be combined with the above values 
when considering the table on which to mount the Arm Base. If the participant viewing 
level is greatly below the tabletop surface then a lower table to mount the Arm Base is 
probably required. 

5.2 Affixing the Arm Base to a Tabletop  

There are two different configurations of the Arm Base, illustrated in Figure  5-3. On the 
left of Figure 4-3 is the configuration of the base for a table that can accept the shim at 
a deep position under its surface. This may be required if there is a lip at the table’s 
edge, and is the default configuration that the system generally ships with. The bolt is 
fully tightened when the unit is shipped and places pressure against a shiny steel shim 
that abuts against the underside of the table.  

Be careful while handling the Arm Base’s shim as it may have sharp 
edges around it centermost hole. 

The Arm Base configuration on the right works with tables that have only a narrow 
ledge on the underside (as small as 18 mm, accommodating tabletop heights of 60 mm 
– 6 cm or 2 3/8”). This configuration is created by removing the long bolt that presses 
against the shim, loosening the screw at the bottom of the base, reorienting the L-
shaped bracket so that the short portion is now perpendicular to the base, and 
screwing the bracket back to the base. The bolt must now be turned through the short 
portion of the L-shaped bracket in order to meet and apply pressure to the shim on the 
underside of the table. Some light viscosity oil may make the turning of the bolt go 
more smoothly but keep in mind that oil will result in discoloration of the paint on the 
arm, so turn the bolt through without using oil if possible.  

To install the Arm Base, use the large supplied L-shaped Allen wrench to unscrew the 
black bolt that has a hexagonal opening in its end. It will have to be unscrewed enough 
to allow the shim perched on its end to fit under the table edge, as the shim will 
eventually be the point of contact between the bottom side of the Arm Base and the 
underside of the table. The large underside of the Arm Base will be the point of contact 
with the Table’s top. Place the base in position, covering the biggest surface area of the 
table as possible and with the shim as deeply under the table as possible. With the 
center hole of the shim on top of the bolt, begin to tighten the bolt while holding the 
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shim so that it does not fall off of the bolt. Pressure will eventually hold the shim in 
place. Tighten as securely as possible. 

 

 

Figure  5-3 Two Configurations of the Arm Mount Base 

5.3 Assembling the Arm Components  

Once the Arm Base has been secured to a sturdy tabletop, it is time to insert the Arm 
into the Arm Base. At this point you may wish to add one or both of the Arm Extenders 
that were included with the system (2.5” and 6” extenders – 6 cm and 15 cm) as these 
raise the overall height of the Arm Mount. Note that using an extender will also raise 
the lowest point that the Arm Mount’s monitor can reach as they simply displace the 
entire unit vertically. The extender shaft simply fits into the silver cup of the Arm Base 
or into the cup of another extender. 

Pick up the Arm with one hand on each of the components to minimize its components 
from swinging. The round silver shaft at the bottom of the arm fits into the silver cup at 
the top of the Arm Base (or one of the optional extenders already inserted into the Arm 
Base) – simply lower the Arm straight into the cup, with cabling off to the side of the 
base that is closest to Display or Host PCs to which the cabling will eventually be 
attached. Several pieces of double-side Velcro ship with the Arm Mount in order to 
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assist users who may wish to wrap the Velcro around the arm components to secure it 
before lifting. This can prevent the arm from swinging while it is being moved. 

The EyeLink 1000 Arm Mount’s Camera and LCD Assembly holds an LCD computer 
monitor, the EyeLink 1000 high speed camera in the level position, and an infrared 
illuminator light source. These are affixed as a single unit that can be easily lifted using 
handles that emerge to either side of the LCD monitor. Facing the back of the monitor, 
grip the handles and guide the shaft of the tilter mechanism into the hole at the top end 
of the arm. Gently wiggle the assembly until the shaft is fully inserted into the arm. 

 

Some configurations of the Arm may require weights at the end of the 
table opposite the Arm Base, to offset the weight of the Arm apparatus. 

 

The Arm is fairly heavy, with the entire apparatus weighing in at approximately 11 kg 
(or 25 lbs). Some possible configurations of the Arm extend the monitor over empty 
space away from the table’s edge, placing the weight of the Camera and Monitor 
Assembly away from the support of the table. To prevent tipping, the table needs to be 
large, heavy and sturdy, or weighted at the end opposite from where the Arm is going to 
extend. Caution should be used when first testing the range of the Arm in case the 
table is not strong enough to properly distribute the weight of the apparatus. If the 
table begins to tip while extending the Arm out into space away from the table, place 
the Arm apparatus back above the table surface and add weight (i.e., the Display 
computer?) to the table surface opposite where the Arm is extending. Repeat this 
procedure until it is clear that the apparatus is stable. 

5.4 Mounting the EyeLink 1000 High Speed Camera  

The EyeLink 1000 Arm Mount requires that the EyeLink 1000 Camera be attached. It 
may have already shipped this way, or you may have to attach a camera that was part 
of a different mounting system. To affix the camera, first remove the cover that 
obscures the camera and illuminator from the bottom front of the Camera and LCD 
Assembly. Two thumbscrews on the underside of the assembly hold the cover in place – 
simply loosen the thumbscrews and the cover will slide off in the forward direction. 

Although not essential, before attaching the camera, it may be convenient to first attach 
the camera data cable that emerges from the Arm to the back of the camera. This is an 
opportune point to attach this cable because once the camera is attach there is not a 
lot of space between the cable interface on the back of the camera and the bracket 
holding the camera (see top of Figure  5-4). The camera data cable is a D shaped cable 
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that can only go in one orientation, and requires thumbscrews to be tightened to assure 
a good connection. The thumbscrews are also slotted so that a slotted screwdriver can 
be used to tighten the screws if your thumbs are not strong enough to do the job. 

Next, mount the camera on the LCD assembly. On the front of the camera is a threaded 
hole that the camera screw from the Arm Mount will go into. This will secure the 
camera. A knob is attached to the opposite side of the camera screw so that it is easy to 
turn the screw into the camera hole. Dimples on the camera fit into protrusions on the 
mount in order to ensure the right positioning of the camera, which should be aligned 
level with the top surface of the part of the mount holding the camera screw. Tighten 
the knob until the camera is secured. Next replace the cover by sliding the slots on the 
cover’s bottom around the thumbscrews on the underside of the assembly. Tighten the 
thumbscrews and adjust the cover so that it is minimally obscuring the IR illuminator 
and the camera. 

 

 

 

Figure  5-4 Rearview of the Arm Mount’s Camera (top) 
and LCD Monitor (bottom) 

5.5 Attaching the Cables  

Integrated into the Arm Mount is the cabling required for the EyeLink 1000 system and 
the computer monitor (camera and LCD monitor power cables, monitor audio cable, 
SVGA video cable, and the camera data cable). After assembling the Arm Mount 
components, inserting the Arm into the Arm Base and attaching the camera, all of the 
cables need to be connected.  
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For all cables emerging from the Arm, location descriptions assume a view of the 
Camera and LCD Assembly from the back underside of the monitor (see Figure  5-4 
bottom). Guide the cables to the side of the camera and illuminator support bracket to 
which the cable will eventually be attached – this will prevent the cable from binding 
against the bracket when the Arm is twisted in various directions. Follow these steps:  

1. First, let’s deal with cables attached to the high-speed camera (Figure  5-4 top).  

• If not already connected before affixing the camera, connect the data 
cable to the interface on the back of the camera that is housed within the 
Camera and LCD Assembly. Tighten the screws by thumb or use a 
slotted screwdriver to tighten. Attaching this cable before attaching the 
camera to the assembly may be easier for some users.  

• Insert the round EyeLink 1000 power supply cable to the power 
connector on the right side of the camera. 

• Ensure that the two illuminator cables are plugged into the side of the 
EyeLink CL high-speed camera – placement is not important. These 
cables are present on the Camera and LCD Assembly and do not emerge 
from the arm. 

2. The remaining cables emerging from the Arm connect to the LCD monitor as 
follows (Figure  5-4 bottom):  

• Insert the phono plug connector into the audio input jack on the bottom 
centre of the LCD monitor of the Camera and LCD Assembly. 

• Connect the SVGA cable to the SVGA input on the right of the LCD 
monitor. Tighten the screws by thumb or use a slotted screwdriver. 

• Connect the 3 prong power chord into the LCD monitor power input on 
the left side of the monitor. 

 

Figure  5-5 Cables Emerging from the Bottom of the 
Arm 
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3. The following cables coming out of the bottom of the arm (shown left-to-right in 
Figure  5-5) are to be connected as described below. Extension cables are 
supplied as indicated in the text. The first cable is the camera high-speed data 
cable and goes to the Host PC, the next two cables go to outputs on the Display 
PC, and the final two go to a power source. 

• Connect the thick camera data cable emerging from the bottom of the 
arm to the EyeLink card on the Host PC. Be sure to tighten the 
thumbscrew connectors or use a flat screwdriver to make a tight connect 
connection. 

• Connect the supplied SVGA extension cable to the SVGA cable coming 
out of the bottom of the Arm Mount. The female end of the cable coming 
from the arm attaches to a male connector on the extension. The 
extension’s female end attaches to the Display PC video card output port. 

• Connect the supplied audio cable extension (female end) to the phono 
plug audio cable emerging from the bottom of the arm. Insert the male 
end into the audio output jack on the Display PC. 

• Connect the supplied three-prong power cable (female end) to the camera 
power supply (male end) that is attached to a cable coming from the 
bottom of the arm. The male end plugs into a power source. 

• Connect the supplied three-prong power extension cable to the LCD 
monitor’s power input and plug the male end into a power source. The 
power supply in the monitor is 110/220 Hz so an adapter may be used 
(supplied) for countries outside of North America and Japan if the 
appropriate extension is not included. 

4. One final cable needs to be attached. Connect one end of the Ethernet crossover 
cable provided with your system to the DLINK Ethernet card port on the Host 
PC. Connect the other end of the Ethernet cable to the Ethernet port on the 
Display PC that you will later configure for use with the EyeLink system. Ensure 
the cable is securely connected at both ends. 

5.6 Adjusting the Tension Points on the Arm 

Occasionally through use of the Arm some of the joints may loosen. Each joint can have 
the tension adjusted so make it require more or less force to move. Loosening a joint 
too much may make it so that it does not stay in the desired position, so tighter tension 
is generally preferred. Tension adjustment points are indicated by hexagonal screws on 



 

Arm Mount Installation 
© 2005-2008 SR Research Ltd. 

27 

 

the Arm and can be adjusted using the Allen wrenches supplied. Recall that all 
hexagonal screws on the Arm are in Imperial units. 

5.7 Arm Mount Adjustments for Monocular and Remote Recording 

The EyeLink 1000 Arm Mount can be used for highly accurate monocular recording 
with head stabilization (in which case the Arm Mount is merely an alternative to the 
desktop or Tower Mount options) or in Remote mode without head stabilization. In 
either case the EyeLink 1000 requires that some information about the physical setup 
be pre-configured in an initialization file PHYSICAL.INI. Regardless of the mode of 
recording, PHYSICAL.INI setup for the Arm Mount is identical to the Desktop Mount 
and is covered in “Section  10.1 Customizing Your PHYSICICAL.INI Settings”. Keep in 
mind when using the Arm Mount however, that for highest accuracy, the viewing 
distance specified in PHYSICAL.INI should be used with the Arm Mount even though 
the Arm may be dynamically adjusted on a per-user basis. 

 

Arm Mount users should proceed to Section 8: Software Installation 

5.8 Disassembling and Transporting the Arm Mount 

The EyeLink 1000 Arm Mount ships with three 60 cm double-sided Velcro straps to aid 
in securing the Arm for lifting and disassembly. A recommended method of securing the 
Arm using the Velcro straps is presented in Figure  5-6. It is recommended that two 
people participate in this task as the unit can be awkward to handle and does contain 
some very expensive and delicate equipment. 

               

Figure  5-6 Securing the Arm for Disassembling and 
Transporting 
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The weight of the Arm with the Camera and LCD Assembly (approximately 11 kg, or 25 
lbs) can cause shaft and cup holder points to become tight due to the pressures that 
the Arm makes while moving the apparatus into various positions. Such pressures 
make what on assembly amounts to merely lowering a shaft into a cup holder not as 
easily reversed. On reversal the pieces need to be gently rocked back and forth to wiggle 
them free. As the Arm is fully loaded this requires rocking of large portions of the entire 
unit. To minimize the potential for damage, as many pieces as possible may be removed 
before attempting to remove the Camera and LCD Assembly from the Arm, or the Arm 
from the Arm Base. For instance, removing the camera cover and camera is advised. 

To disassemble the unit, one option is to lift the Arm and Assembly together from the 
Arm Base. A second option is to remove the Camera and LCD Assembly from the Arm 
first, and then to remove the Arm itself from the Arm Base. In either case, double-sided 
Velcro strapping can assist in securing parts of the Arm to make disassembly more 
manageable. 

Once the Arm has been removed from the Arm Base, removal of the Arm Base involves 
loosening the bolt from applying pressure to the shim until the Arm Base can slide 
freely off of the table. Be careful when handling the shim, as it may have sharp edges 
created around the center hole from the pressure applied to it. 

Important: It is recommended that two people participate in 
disassembling the Arm Mount.  

Read these instructions through and prepare a place to put the 
disassembled pieces before attempting disassembly. 

5.8.1 Option 1: Remove Arm and Camera Assembly as a Unit 

First fold the Arm as pictured in Figure  5-6. The Camera and LCD Assembly can be 
lowered so that the camera bracket is beneath the bottom limb of the Arm. Raising it 
slightly can put pressure on the cable cover which may mark the cover, so some 
packing material may be inserted between these to prevent marking if desired.  

Wrap Velcro (soft side against the Arm is recommended) around the Arm so that it will 
not extend when lifted (see Figure  5-6). Although full Arm extension is prevented by the 
camera bracket pressing against the cable cover, the possibility exists for body parts to 
become pinched.  

The entire Arm, with intact Monitor Assembly can now be lifted from the Arm Base. One 
person may need to apply downward pressure to the table while the other does the 
lifting, so that the table is not merely lifted off the floor. Some wiggling of the Arm and 
its shaft may be required to make it come free from the Arm Base’s holder cup. Once 
free the unit may feel top heavy, so be sure to have a strong grip. Gently lower the unit 
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onto an awaiting soft foam surface, such as the inside of a hard shell case molded for 
transport and storage of the Arm Mount. 

5.8.2 Option 2: Remove Camera Assembly then Remove the Arm 

Fully extend the Arm and ensure there is nothing preventing the upwards lifting of the 
Camera and LCD Assembly. One person will have to steady the Arm and put 
downwards pressure on the top of the Arm while the other person grabs onto the 
monitor handles and lifts upwards. Some rocking of the Monitor Assembly back and 
forth to dislodge it may be necessary. 

Once free of the cup holder, the Camera and LCD Assembly can be placed on a hard 
surface with the bracket making contact with the table. At this point the Arm can be 
removed from the Arm Base with one person applying downward pressure on the table 
while the other person lifts up on and wiggles the Arm free of the Arm Base. 
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6. Primate Mount Installation 

The EyeLink 1000 Primate Mount is a metal bracket that contains an illuminator for 
use with the EyeLink 1000 camera. The camera is affixed to the top of the mount 
pointing downwards and the researcher supplies an apparatus that will reflect a view of 
the eyes up into the camera barrel while reflecting the infrared illumination onto the 
face of the subject being tracked (see Figure  6-1). Typically this would involve the 
researcher fixing a ‘hot mirror’ (a piece of glass that reflects infrared light while allowing 
other wavelengths to pass through it) in front of the subject’s eyes. The subject can 
thereby see visual stimuli being shown by looking through the hot mirror, while the 
camera has a good view of the eyes. Typically the distance between the camera and 
where the eye would be for monocular recording would be identical to the Tower mount 
– 380 mm. 

While the Primate Mount uses a similar set of metrics to the Tower Mount, it is 
intended to be flexible and ready to install in a wide range of situations where a means 
of head stabilization exists but the Tower or Desktop mounts are inappropriate. This 
frequently occurs when research on eye movements is being performed on Primates 
with their head fixed, for instance by means of a Primate Chair. If the head is fixed 
extremely solidly, pupil only tracking may be possible, otherwise, as with the other 
EyeLink 1000 mounting options, Pupil-CR mode is recommended. 

 

Figure  6-1 Typical EyeLink 1000 Primate Mount 
Installation 
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6.1 Primate Mount Hardware Considerations 

As experimental setups using this mount vary widely, following something akin to 
Figure  6-1 is recommended, but other configurations are possible. The configuration 
depicted, assumes use of the 25 mm lens, but other lenses can be used for different 
viewing distances. As with the Tower mount, but not with the other systems, there is 
lots of room for movements of the hand in front of the body using the Primate Mount. 

All system and optical components can be seen in the overall rear and side view 
drawings. The optical axis is represented in Figure  6-1 by the thin dotted line. The 
camera is placed above a 45°hot mirror (which reflects IR light but transparent to 
visible light) that reflects an image of the eye to the camera. The subject views the 
stimulus source (such as a computer monitor) through the mirror. The illuminator 
module is mounted and angled so as to illuminate the eye via the mirror as well (the 
direct path from illuminator to eye is represented by the heavy broken line). 

The illuminator should be angled to maximize illumination of the eye while minimizing 
bright spots and shadows on the face. For human subjects, this may require placing 
the illuminator to the temporal side of the tracked eye to reduce nose and forehead 
bright spots and shadows on the temporal side of the eye socket. The illuminator is 
normally located significantly closer to the eye than in the Tower mount (typically 
~180mm from front of illuminator to eye). This distance results in an eye illumination 
level of ~1.0 mW/cm2 at the eye (which is comfortable for extended viewing) with a 
reasonable size corneal reflection. 

The EyeLink CL illuminator bracket is designed to provide a rigid connection between 
the illuminator module and the camera. This is essential for pupil-CR difference 
tracking mode, as any motion of the illuminator relative to the camera will appear as 
eye rotation artifacts. This is also true to a lesser extent for pupil-only eye tracking 
mode, if the CR is positioned within the pupil itself. The camera attaches to the bracket 
with a clamp knob and 3 indexing bumps for positive alignment. The camera may also 
be attached to the bracket rotated by 180°, to change the side of the bracket the lens is 
on. The illuminator block attaches to the bracket with a single clamp knob in a slot, 
allowing the distance from the illuminator to the eye to be changed to control 
brightness and CR reflection size, and the illuminator to be rotated to maximize 
illumination. The LEDs used in the illuminator were selected for even illumination, so 
angling the illuminator is not critical. 

The illuminator consists of an array of 24 infrared LEDs mounted in a heatsink block.  
The block also allows for mounting of the assembly via an M8 thread in each side. It is 
important that the illuminator be mounted to a substantial piece of metal to help cool 
the illuminator as this will enhance light output. The IR LEDs emit at 910 nm, which 
was selected for reduced visibility in dark-adapted conditions compared to typical 880 
nm LEDs. The LED array is safe for viewing by humans at any distance (it passes the 
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IEC 60825-1 standards by a factor of 3) at any distance, however distances of >160mm 
from the eye (resulting in irradiance of <1.2mW/cm2) are recommended for long-term 
viewing comfort. 

The camera mounts to the top of the bracket using a clamp knob (M8 thread) and a set 
of dimples on its front.  This ensures that the camera cannot vibrate independently of 
the illuminator. The camera also has 5 mounting holes on its sides: 2 near the center of 
the camera’s sides, and 3 aligned with the optical center of the lens and sensor. These 
holes take a standard 1/4”-20 screw (used on tripod and camera mounts). However, the 
hole at the lens end of the camera may not be robust enough to mount the camera with 
the illuminator bracket attached, especially if vibration is present. 

It is recommended that the illuminator bracket be mounted to the head restraint 
assembly using the 3 holes supplied near the camera mount.  The long side of the 
bracket should be oriented away from the subject to maximize head clearance. Once 
the bracket is mounted, the illuminator and camera may be attached and re-oriented 
as required. The camera may be installed with the lens on the left or right side of the 
bracket, and the illuminator fitted as required to place the connector on the side 
opposite the camera lens.  The EyeLink configuration files may be modified to flip the 
camera image as required to match any mirrors or orientation of the camera. 

While the camera will accept most C-mount lenses, the performance of most lenses is 
rather poor in infrared, with blurry or dark images resulting from lens coatings or non-
optimal design.  The standard camera configuration uses a 25mm focal length lens, 
selected for high resolution and excellent IR performance.  A similar 16mm focal length 
lens is available which will allow the camera to function properly when closer to the 
eye. 

As with other EyeLink 1000 mounting options, the camera requires a 12V power, and a 
supplied 60mm (24”) cable is connected from the camera to power the illuminator 
module.  A supplied ferrite choke on this cable must be on the end near the camera.  
Finally, a high speed camera cable is connected from the back of the camera to the 
tracker host computer.   

To summarize the above points, when installing the primate system, please keep the 
following points in mind: 

• The camera should not be too close to the eye, as the pupil and corneal 
reflection must be contained within the tracking window. 

• Bringing the illuminator closer to the eye will reduce noise but may cause 
discomfort and increase pupil erosion by the corneal reflection. 

• Placing the illuminator too far from the eye will result in a dark image and noisy 
data.  
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• The line from the illuminator to the eye should be at least 10°off-axis from the 
camera lens for proper imaging. 

• The illuminator should be attached to a robust metal support, as should the 
camera.  Preventing separate motion of the camera and illuminator due to 
vibration is critical to prevent extraneous noise in the data. The metal will also 
help to keep the illuminator cool, increasing its light output. 

• While it is possible to rotate the camera by 90°, this will swap X and Y pupil 
position data. Contact SR Research for information about operating in this 
configuration. 

• It is possible that an extra bright reflection may appear above the pupil in the 
eye image, as the illuminator may directly light the eye as well as through the 
mirror.  A small baffle may be required to control this. 
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7. Attaching EyeLink 1000 System Cabling 

For system cabling, please follow the wiring diagram in Figure  7-1. 

 

Figure  7-1 System Set-up and Cabling 

The basic cabling steps are: 

1. If not already done, attach the keyboards, mouse, power cords, monitors etc. to 
the Host and Display PCs. 
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2. Connect one end of the Ethernet crossover cable provided with your system to 
the DLINK Ethernet card port on the Host PC. Connect the other end of the 
Ethernet cable to the Ethernet port on the Display PC that you will later 
configure for use with the EyeLink system. Ensure the cable is securely 
connected at both ends.  

3. Connect one end of the CameraLink Cable provided with your system to the 
Phoenix High-speed Frame Grabber card in the Host PC. Connect the other end 
of the cable to the top of the EyeLink CL high-speed camera. Ensure the cable is 
firmly attached at both ends, with the two thumb screws tightened to lock the 
cable in place. Please note that if you have purchased both the Tower Mount 
and Desktop Mount, you will receive two CameraLink cables. The cable that has 
a right angle connector should be used on the Desktop Mount. 

4. Ensure that the two illuminator cables that come out of the head support Tower 
or Desktop Mount have been connected to the left side of the EyeLink CL high-
speed camera.  

5. Connect the EyeLink CL power supply that was provided with your system to 
the power connector on the left side of the EyeLink CL camera. After the power 
supply has been connected to the camera, connect the power plug to a power 
surge protector. 

 

Important: Do not use any other power supply with the EyeLink CL camera 
other than the one provided with your system. 

 

6. Plug the supplied USB game pad into a USB port on the Host PC. Use the 
optional USB extender cable if the game pad needs to have a cord longer than 
one meter.  

NOTE: The USB game pad must be directly connected to a USB port on the 
Host PC and cannot be connected through a USB hub. 

 

7. If an analog card was installed in your Host PC, connect one end of the supplied 
analog card cable to the analog card connector on the Host PC. Connect the 
other end of the cable to the analog breakout board that was provided with the 
Analog card option. Ensure the cable is firmly attached at both ends and that 
the thumb screws have been tightened to lock the cable in place. 
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8. Host PC Software Installation  

Both the Host PC and Display PC need to be configured for use with the EyeLink 1000 
system. This chapter details Host PC software installation and the next chapter details 
Display PC software installation. 

8.1 Installation on a Computer Running Windows 2000/XP 

The first step in preparing your Host PC for the EyeLink 1000 is to install the ROM-
DOS operating system that the EyeLink 1000 system runs on. This allows you to 
perform subject setup, monitor performance, record data, and control experiments 
running on the Display PC. At the same time, you will want to keep your existing 
operating system accessible so that you can access your CDRW drive etc. when 
required. To achieve this, you will create a FAT32 partition on your hard drive using 
System Commander that will host the ROM-DOS OS provided with your EyeLink 1000 
system. System Commander will also be used to allow you to choose which operating 
system you wish to launch when you start the Host PC.  

 

Important: If you have a floppy disk drive, 
create the System Commander rescue disks 
when prompted during installation. These may 
help you recover the drive partitions in the 
future, in the event of file system corruption on 
the drive. 

Your System Commander license is registered 
through SR Research Ltd. 

Figure  8-1 License Code Entry 

8.1.1 Install System Commander 

Install the System Commander application that came with your EyeLink 1000. This 
application allows the user to manage multiple Operating Systems on one computer.  

1. Boot into Windows as normal. Insert the “EyeLink 1000 Software” CD into your 
CD drive. 

2. Access the CD-ROM contents by double-clicking on “My Computer” and 
selecting the CD-ROM drive. Open the ‘Host PC Installation\Utilities’ folder and 
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run the SystemCommander811.exe file to install the System Commander 
software. 

3. Click the INSTALL button on the opening screen and follow the instructions to 
install the System Commander software. The license number will be on the front 
of the EyeLink 1000 Software CD case – enter it when you see the screen 
illustrated in Figure  8-1. You are only licensed for 1 copy of this software for use 
on the EyeLink 1000 Host PC. The installer will prompt you to create ‘Rescue 
Disks’, to register, to check for updates from the web, etc. None of these steps is 
critical, so they may be skipped if you are in a rush or do not have a floppy 
drive. 

4. After installation, run the System Commander program by going to the Windows 
“Start Menu” and selecting the “System Commander” entry. 

5. Given the “Utility Wizard” dialog box that will automatically be displayed (see 
Figure  8-2) select the “Enable System Commander” entry, click on “Next”, exit 
the System commander program and restart the computer. The computer will 
boot into the System Commander interface as shown in the left side of Figure 
 8-3. 

 

Figure  8-2 Enable System Commander 

8.1.2 Resize Existing Disk Partition  

Upon restart the computer will automatically run the System Commander application 
(this will happen every time the computer is powered up). The next step is to resize the 
existing partition to make space for a 5GB EyeLink Host Application partition.  
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Figure  8-3 Select Partitioning then Manual Partitioning 

1. Having just rebooted your Host PC, you will see something like the window 
on the left of Figure 8-3. Click the ‘Partitioning’ button from the ‘OS 
Selection Menu’, then select ‘Manual Partitioning’ as illustrated in Figure 
 8-3. If your computer reports that it is “Analyzing” for an extended period of 
time (i.e., more than a few minutes) then: 

i. Boot from the supplied “System Commander Boot CD” – insert it into 
the CD drive and restart the computer 

ii. Press F12 to get the Boot Menu and the internal CD as the boot 
device 

iii. Select “Partition Commander or Restart” and continue with step 
number two below. 

 

 

 

Figure  8-4 Partition Selection and Resize 
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2. From the ‘Partitioning’ window select the disk and the partition to resize. In 
System Commander, each disk is represented as a cylinder. Within these 
cylinders are differently colored partitions. The partition (typically, this will 
be in the primary disk) that should be resized to make a new partition will 
normally be the largest chunk within the selected disk. Highlight this 
partition as illustrated in Figure  8-4 left, and then click on the “Resize” icon. 

3. In the “New size (MB)” field of the Resize Partition dialog box (Figure  8-4 
right), enter a value that is 5120MB less than the indicated ‘Current Size’. 
For example, if the original disk size is 76253 MB, you should put 71133 
MB in the new size field. 

4. Press ‘Next’ to do the resizing of the drive. System Commander may adjust 
the partition size you entered slightly. This is expected and is not an issue. 

 

 

Figure  8-5 Partition and Partition Type Selection 

8.1.3 Create the EyeLink 1000 Host Application partition  

1. From the ‘Partitioning’ window select the newly formed ‘Free’ space (highlighted 
in gray) which will appear on the top of the cylindrical drive diagram as 
illustrated in the left side of Figure  8-5. Click the ‘Create’ icon which will bring 
up the ‘Create Partition’ window. 

2. Select ‘Primary’ and click ‘Next’ which will bring up the ‘Create Primary Partition’ 
window as illustrated in the left side of Figure  8-6 Create a Custom FAT 32 
PartitionIn the ‘Volume label’ field type EYELINK and ensure that the ‘Custom 
Partition Type’ box is checked. Click ‘Next’ to bring up the ‘Custom Partition 
Type’ window as illustrated in Figure  8-6 right, and select ‘FAT-32’ then click 
‘Next’. In the following ‘Warning!’ window, click ‘Proceed’. 
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Figure  8-6 Create a Custom FAT 32 Partition 

3. Close the ‘Partitioning’ window by selecting the red “X” in the top right corner of 
the window and exit System Commander by clicking "Start" at the bottom-left 
corner of the screen selecting the "Exit" option.  

4. Upon restart the computer will once again automatically run the System 
Commander application. The new EyeLink partition will appear as the icon with 
two question marks and will be labeled ‘FAT-32 OS’ as illustrated in Figure  8-8. 
We will return to deal with this later. For now, we wish to boot into Windows 
once again. 

5. Select the Windows XP partition. Windows XP should immediately determine 
that the disk partitioning has changed and perform a number of system 
tests to validate the hard drive. This is expected and should not be 
interrupted.  

6. Windows will reboot once its validation checks have been performed. From the 
System commander menu select Windows XP a second time and boot into the 
Windows operating system. 

8.1.4 Copy the Host Application files to the New Partition  

The next required step is to copy the Host PC application files from the supplied 
“EyeLink 1000 Software” CD onto the newly created EyeLink partition. 

1. From Windows, start Windows Explorer. If you have removed the “EyeLink 1000 
Software” CD from your CD drive, reinsert it. Navigate to the “Host PC 
Installation \ Host Partition” folder.  

2. Copy all of the files in this folder to the top level of the newly created EyeLink 
FAT-32 drive (often E:\). The EyeLink CD has copy of all the files required for 
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the Host partition, including a required camera-specific .SCD file. Hence the CD 
is required, and it is a good idea to keep the EyeLink 1000 Installation CD in a 
safe place. 

In some cases it Windows may hide certain operating system files (i.e., files 
ending in .INI or .BAT). If you do not see a .BAT file when you view the contents 
of the Host Partition folder, you can set Windows to ‘see’ these files using the 
following steps: 

i. Select the Tools → Folder Options… menu in Windows Explorer. 

ii. Select the View tab. 

iii. Select the “Show hidden files and folders” option under Hidden files and 
folders. 

iv. Ensure “Hide extensions for known file types” is not selected. 

v. Uncheck the “Hide protected Operating system files….” as illustrated in 
Figure  8-7. 

 

Figure  8-7 Windows Explorer Tools Folder Options… 
Dialog 

 

vi. Press OK. 
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vii. Select all files in the “Host Partition” folder of the CD. 

viii. Copy these files to the root directory of the EyeLink 1000 drive on your 
computer. 

3. To return Windows so that it hides operating system files complete the following 
steps: 

i. Select the Tools → Folder Options… menu in Windows Explorer. 

ii. Select the View tab. 

iii. Deselect the “Show hidden files and folders” option under Hidden files 
and folders. 

iv. Check the “Hide protected Operating system files….” 

4. If your host PC uses a USB keyboard please proceed to section’  8.1.5 
Configuring the USB Keyboard’. 

5. If you have a PS/2 keyboard please continue to section “ 8.1.6 Transfer the 
System to make the EyeLink Partition Bootable” 

8.1.5 Configuring the USB Keyboard 

The PS/2 keyboard is the default driver setup within the EyeLink Host directory. If 
you are using a USB keyboard, rename the file to activate the USB keyboard driver. 

1. Locate the “ELCL.INI” file in the “ELCL\EXE” directory of the host partition. 
Rename it to “ELCL.PS2”.  

2. Rename the “ELCL.USB” file to “ELCL.INI”. 

8.1.6 Transfer the System to make the EyeLink Partition Bootable 

1. Insert the CD labeled “ROM-DOS Boot Disk” that came with the EyeLink 1000 
system, and restart the system as you normally would via Windows. The next 
step is to boot off of the CD. You may need to press F12 before System 
Commander is run to boot off of the CD-ROM device. With some newer types of 
hardware choosing to boot from the CD-ROM from within System Commander 
does not work as desired. 

2. You will know that you have successfully booted from the CD-ROM of you are 
given a ROM-DOS command prompt. 
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IMPORTANT: The following step requires you to determine the correct drive 
letter (c:, d:, etc) for the EyeLink 1000 partition you created above after 
booting with the ROM-DOS Boot Disk. Determine this by using the dir 
command (e.g. dir c:) for each drive to find the EyeLink drive label and 
substitute that drive letter (c:, d:, etc) in place of {EYELINK DRIVE}  below. 
It is likely that the drive letter will be either c: or d:   

3. At the command prompt 'A:\>’ type the following command: 

sys {EYELINK DRIVE} [ENTER] 

For example if your EyeLink partition is drive c: you will enter: 

sys c: 

and then press the enter key. 

4. Reboot the computer. Once System Commander runs, you should see 
something like the screen pictured in Figure  8-8 with ?? and FAT-32 describing 
the EyeLink Host partition. 

 

Figure  8-8 Select Partition to Rename 

8.1.7 Organize System Commander’s ‘OS Selection Menu’ 

1. When System Commander starts up, you will see a screen similar to Figure  8-8 
Select Partition to Rename. Click on the ‘Settings’ icon. 

2. From the ‘Settings’ window, select ‘Descriptions and Icons’ as illustrated in the 
left side of Figure  8-9. 

3. From the screen in the right side of Figure  8-9 click on the arrow buttons of the 
‘Current Selection’ box to select the ‘FAT-32 OS’. In the ‘EDIT DESCRIPTION’ 
box type EyeLink. Under ‘SELECT ICONS’, use the ’+’ and ‘-‘ buttons to change 
both large and small icons to ‘OS’. 
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Figure  8-9 Select Description and Icons 

  

Figure  8-10 Order Add and Remove 

4. Click ‘OK’ to finish. Then from the ‘Settings’ window, select ‘Order Add and 
Remove’ as illustrated in Figure  8-10. 

5. From the ‘Order Add and Remove’ window, remove all icons except for the 
Windows XP and EyeLink by highlighting each one and clicking the ‘Remove’ 
button as in the right side of Figure  8-10. 

6. Highlight the EyeLink OS and click the ‘Top’ button to make EyeLink the default 
partition. 

7. Click ‘OK’ to finish and close the ‘Order and Remove’ window. 

8.1.8 Automated boot into the EyeLink 1000 Operating System 

1. If you would like System Commander to automatically boot into the EyeLink 
partition, click on ‘Timeouts and default OS’ from the ‘Settings’ window. 
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2. Check the box beside ‘Auto-select timeout’ and set the number of seconds for 
System Commander to wait before booting the default operating system. 
Indicate the default OS in the ‘Default OS selection’. If you followed the earlier 
instruction, EyeLink will be the first OS and can be selected by choosing ‘A’. 

3. Once you have completed this step, close the windows by clicking the X in the 
top right corner. You will be returned to the main System Commander window 
and are now ready to test the installation. 

8.2 Testing the Host PC Installation 

From the System Commander main screen, select the EyeLink 1000 partition by 
clicking on the OS icon. You should see a C:\> prompt at the command line. If you 
do not, the EyeLink 1000 partition is not bootable and you should repeat the steps 
in section ‘ 8.1.6 Transfer the System to make the EyeLink Partition Bootable’. 

Start the EyeLink 1000 Host application by typing:  
T [Enter] 

The EyeLink 1000 Host PC application should start and you should see the 
EyeLink 1000 Host application screen illustrated in Figure  8-11. Please make 
sure that you are using version 4.0 or later of the EyeLink 1000 host application; 
the latest host software can be downloaded from SR Research support website 
http://www.sr-support.com. 

IMPORTANT: Each EyeLink 1000 system loads a camera-specific .SCD file. 
If you see the following error when starting up the tracker, please ensure 
that “********.SCD” file is contained in the ELCL\EXE directory. 

ERROR: Camera data file ‘c:/ELCL/EXE/********.SCD’ does not exist 

You can find the camera-specific .SCD file in the Host Partition \ ELCL \ 
EXE directory of the EyeLink 1000 Software CD that came with your system. 
If you cannot locate this file, please contact SR Research Ltd.  

Click on the “Set Options” button and ensure that the “Mouse Simulation” button 
is deselected as in Figure  8-12 (the button will not be solid in color). Next click on 
the button marked “Setup Camera” and if all is working well, you should see that 
the camera is transmitting images to the Host application. 

A screenshot of the large field of view of the EyeLink 1000 camera (Tower Mount) is 
illustrated in Figure  8-13. 



 

46 Host PC Software Installation 
© 2005-2008 SR Research Ltd. 

 

Please consult the EyeLink 1000 User Manual for tutorials on setting up the 
camera, calibration and validation. Bur first, proceed with the Display PC setup in 
the following chapter. 

 

Figure  8-11 Host Application in Offline Mode at Startup 

      

Figure  8-12 Host PC Set Options Screen 

     

Figure  8-13 EyeLink 1000 Camera Setup Screen 
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8.3 EyeLink Data Storage 

All EDF files that are created during the recording phase of each experiment will be 
saved to C:\ELCL\DATA. This is the default directory into which EyeLink recording files 
(.EDF) are stored. If the DATA drive cannot be found, all EyeLink data files will be saved 
into the C:\ELCL\EXE directory. It is recommended to periodically boot into 
the Windows 2000/XP operating system to back up your data. Editing the parameters 
in the ‘Data.ini’ file can change the path into which the data is stored. 
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9. Display PC Software Installation 

The Display PC is used to run experiment application software for control of the 
EyeLink 1000 tracker and stimulus presentation through the EyeLink Display 
Software. This API is available on Windows, MacOS and Linux platforms. The Display 
PC installation process is much less complicated than the Host PC installation and 
should not take more than 15 minutes. Installation instructions for the Windows 
platform are detailed below.  

9.1 Windows Installation 

To use Windows as a Display computer with the EyeLink 1000 system, various EyeLink 
software components should be installed on the Windows Display PC. The installation 
process consists of the following basic steps: 

• Install the EyeLink Experiment Programming Kit. 

• Install the supplied IO Port Access Driver if planning to use TTL. 

• Install the EyeLink Data Viewer and / or Experiment Builder software (if 
purchased). 

• Install the USB Key drivers for EyeLink Data Viewer and / or Experiment 
Builder software (if purchased). 

• Configure the network connection to the EyeLink 1000 Host PC. 

9.1.1 Installing the EyeLink 1000 Experiment Programming Kit 

The Windows toolkit (API and example files) is available on the “EyeLink 1000 Software” 
CD in the “Display PC Installation” directory. To install the toolkit: 

1. Insert the “EyeLink 1000 Software” CD. 

2. Open the “Display PC Installation → Windows” folder. 

3. Run the EyeLinkDevKit_*.exe program by double clicking the icon. 

4. Follow the instructions from the InstallShield Wizard to install the display 
software. 

5. Wait for the InstallShield Wizard to finish, and click FINISH to complete 
installation. 
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9.1.2 Installing the IO Port Access Driver 

For proper access to IO ports (i.e. for TTL signalling) on the Display PC, an access driver 
must be installed. The EyeLink 1000 Windows API relies on this driver for IO port 
access so installation is mandatory.  

1. To install the driver, click Start → Programs → SR Research → EyeLink → 
Utilities → PORT95NT. 

2. Follow the on screen instructions. 

3. Reboot your computer when prompted. 

9.1.3 Installing the EyeLink Data Viewer and Experiment Builder Software 

The EyeLink Data Viewer and Experiment Builder software are optional Windows 
applications for the EyeLink eye tracker. If you did not purchase these options this 
section may be skipped, or you may install the software to evaluate in demo mode. 

1. Insert the “EyeLink 1000 Software” CD. 

2. Open the “Display PC Installation → Windows-> EyeLink Data Viewer” folder. 

3. Run the EyeLinkDV_*.exe program by double clicking the icon. 

4. Follow the instructions from the InstallShield Wizard to install the software. 

5. Wait for the InstallShield Wizard to finish, and click FINISH to complete 
installation. 

6. Open the “Display PC Installation → Windows-> SR Research Experiment 
Builder” folder 

7. Run the SREB_*.exe program by double clicking the icon. 

8. Follow the instructions from the InstallShield Wizard to install the software. 

9. Wait for the InstallShield Wizard to finish, and click FINISH to complete 
installation. 

9.1.4 USB License Key Installation 

If you purchased either the Data Viewer or Experiment Builder software, you will 
have been provided with a USB license key with your order. To install the software 
driver for the USB license key follow these steps: 

1. From the Windows Start menu select “Start->All Programs -> SR Research -> 
Install HASP Driver” 



 

50 Display PC Software Installation 
© 2005-2008 SR Research Ltd. 

 

2. Follow the instructions from the InstallShield Wizard to install the software. 

3. Wait for the InstallShield Wizard to finish, and click FINISH to complete 
installation. 

4. Insert the USB Key into a free USB port on the Display computer. The USB key 
should start to glow a reddish – purple color, indicating that the key has been 
recognized by the system.  

9.1.5 Setting up EyeLink 1000 Network Connection 

You must have an Ethernet port in your Display Computer. Allow Windows to install 
drivers for it (if it is new hardware), then follow these instructions to install and 
configure the TCP/IP network protocol. These instructions are based on Windows XP, 
other Windows operating systems may vary slightly. 

1. From the Start menu select the Control Panel. 

2. Click on the Network and Internet Connections icon, and then select the network 
Connections icon. Check the list of installed components to make sure a 
network card is installed. If not, install a driver for the card. 

3. Double click on the network card icon that represents the network card that will 
be connected to the EyeLink 1000 Host PC. 

4. Select the properties button. 

5. Check that “TCP/IP” is displayed in the list of components and that it is 
checked. If not, press the checkmark beside the option.  

6. Select the “TCP/IP” component for the Ethernet card connected to the eye 
tracker PC, then click on the “Properties” button.  

7. Select the “Use the following IP address” radio button. Enter the IP address of 
“100.1.1.2”. The last digit of the IP address can increase for other computers 
on the EyeLink network. Enter the subnet mask of “255.255.255.0”. Leave the 
default gateway and other setting blank.  

8. Click on “OK” to return to the Properties dialog. Click “OK” again to save your 
changes. Click “Close” to exit from the network card dialog. 

If connectivity error messages appear ensure the supplied Ethernet crossover cable 
connects the configured Ethernet port of the Disply PC to the supplied network card of 
the Host PC. Alternatively, you may need to reinstall the network card drivers. To be 
safe, open the Network dialog and remove all components, restart Windows, then install 
the network card driver and the TCP/IP protocol again.  
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To test the network, start the EyeLink 1000 tracker and start the “track” application 
from “Start -> Programs -> SR Research -> EyeLink -> Track”. The link should connect, 
and the screen will display instructions. This application allows you to practice 
participant setup and test the system, as described in the EyeLink 1000 Installation 
Guide. If the message “Cannot initialize link” appears, the TCP/IP protocol or crossover 
cable is/are not properly configured. If the connection times out, it is probably due to 
the network card being improperly configured or because the network cable is not 
connected to both PCs. 

9.1.6 System and Programming Tools Required 

The experiment templates in this package were developed using Microsoft Visual C 6.0. 
Other 32-bit C and C++ compilers may be used, but you will have to translate the 
included make files to rebuild the experiments. This release of the Windows Display 
Software does not supply examples for C++ programming. 
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10. Final Installation Steps 

This section lists the final installation steps to fine tune your EyeLink 1000 installation. 

10.1 Customizing Your PHYSICICAL.INI Settings  

The EyeLink 1000 PHYSICAL.INI file at C:\ELCL\EXE directory contains settings that 
tell the system about physical characteristics of your setup that are important for 
proper visual angle and eye velocity calculations. Any time you change your physical 
configuration you should verify that the PHYSICAL.INI still accurately reflects your 
setup.  

The parameters in the PHYSICAL.INI file that change depending the physical setup of 
your system are: 

screen_phys_coord – specifies the physical distance of the four edges of the 
presentation surface, to the center of the screen. The order of these measurements is 
left, top, right, bottom and are specified in millimeters. For the default case of a 19” 
monitor this parameter will read. 

screen_phys_coords = -178.0, 135.0, 178.0, -135.0 

screen_pixel_coord – specifies the resolution of the display surface. Normally the 
EyeLink 1000 API at the start of an experiment programmatically adjusts this so you do 
not need to manually change this setting. If the EyeLink 1000 programming API or 
Experiment Builder is not being used, then the default value for this parameter will 
apply. The default value reads.  

screen_pixel_coords = 0.0, 0.0, 1024.0, 768.0 

screen_distance – specifies the distance to the top and bottom of the display surface 
from the participant’s eye. This setting is not applicable to EyeLink remote tracker. The 
default values read as following:  

screen_distance = 600 660 
 

10.1.1 Measuring screen_phys_coords 
 

All screen physical coordinate measurements are in millimeters. It is recommended that 
a straight ruler be used. Turn on both the EyeLink 1000 Host and Display PC and run 
track.exe on the Display PC. Type in “TEST” for the saved EDF file name and click the 
OK box. Press “Enter” on either keyboard twice.  
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On the Host PC go to “Set Options” on the screen and select “mouse simulation” mode. 
This will now let you use the Host PC mouse to simulate eye movements. Check that 
the Calibration Type is set to a nine-point pattern. Press “Previous Screen” button to 
return to the Camera Setup screen. 

Now press “C” or the calibration button. A calibration dot should appear on the middle 
of the display monitor. Use this dot as the central reference point for all horizontal and 
vertical PHYSICAL.INI measurements. 

In the screen_phys_coors, measure the distance from the center of the dot to the end of 
the active part of the monitor screen. Start on the left side (S1) and follow round to the 
top (S2), right (S3) and bottom (S4). This is illustrated in Figure 9-1. 

 

 

Figure  10-1 Measuring screen_phys_cords 

The new settings for the screen_phys_coords in the PHYSICAL.INI file are determined by 

screen_phys_coords = -1, 2, 3, -4  
 

10.1.2 Measuring screen_distance 

Please follow the steps below to measure the “screen_distance” values. For EyeLink 
Remote eye tracker, keep the default “screen_distance” value. 

1. Set up the monitor and chinrest so that the chinrest is centered on the monitor and 
the monitor is horizontally aligned with the chinrest (HINT: measure from the left 
and right knobs on the chinrest to the left and right sides of the top of the display 
area of the monitor, these should be equal).  
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2. Adjust the height and tilt of the monitor. Ideally this should have the top of the 
display at about the same height as the forehead rest, and the display tilted up 
slightly. The tilt can be changed if there are any reflection issues. Small amounts of 
horizontal misalignment (turning of the monitor) may be tolerated if required to 
reduce screen reflections, but this will reduce the accuracy of angular measures. 

3. Now measure from the front of the forehead rest/Tower height adjustment knob (or 
the subject’s eye position if using your own chin rest) to the point on the monitor 
directly in front of the knob (lay the measuring tape across the top of the shaft of 
the knob, and read distance from the front of the column). Measure from the knob 
to the top of the visible part of the display area, then from the knob to the bottom of 
the display area. These two values (in millimeters) should be your new 
“screen_distance” command values.  

10.1.3 Entering Values into PHYSICAL.INI 
 

The newly acquired values for “screen_phys_coords” and “screen_distance” must now 
be entered into the PHYSICAL.INI located on the Host PC. This can be done either from 
the Windows partition or from the EyeLink partition. 

10.1.3.1 Windows Partition 

Boot into the Windows partition, find the EyeLink drive. Go to the “ELCL\EXE” 
directory and select the PHYSICAL.INI file. Uncheck the "read-only" property of the file. 
Modify the file and save the change. 

10.1.3.2 EyeLink Partition 

Reboot the Host PC into the EyeLink partition. Do not press “T” when in the DOS 
prompt before running the EyeLink 1000 GUI.  

 
From the command prompt type the following 
 
 CD C:\ELCL\EXE 

 ATTRIB –R PHYSICAL.INI 

 EDIT PHYSICAL.INI 

 

To enter the new values, follow these steps 
 

1. Go to the screen_distance parameter 

2. Remove the default values for this command. 

3. Enter new values 
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4. Repeat steps 1-3 for screen_phys_coords 

5. Save changes and exit the file 

 
Finish by typing the following at the command type 
 ATTRIB +R PHYSICAL.INI 
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